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This software operates under the Microsoft Windows 95, 98, NT4.0 Workstation, Me, 2000
Professional, XP Home or Professional Edition operating systems. This manual references
only these Microsoft Windows Operating Systems and compatible mouse devices. For details
please refer to the Microsoft Windows operation manual.
If there are any terms in the manual you do not understand, please refer to “Glossary”
(page 99).

Note that Sharp Advanced Presentation Software Professional Edition is subject to
change without prior notice for upgrading and improvement.
The latest information on this software can be found at the following web site:
http://www.sharp-world.com/projector/

� Microsoft and Windows are registered trademarks of Microsoft Corporation, USA.
� All other brand or product names are trademarks or registered trademarks of

their respective holders.
� Great effort has been expended to ensure that the descriptions in this manual

are correct. Should you, however, come across an inconsistency, a telephone
call or letter to SHARP Corporation noting the questionable area would be highly
appreciated.

� This software is the property of SHARP Corporation and all related copyright and
other rights belong to SHARP Corporation.

� This manual may not be transferred wholly or in part in any form whatsoever
without prior written permission. Uses other than personal use are for copyright
reasons not permitted without the written permission of SHARP Corporation.

� SHARP Corporation shall in no event be liable for damages, loss of revenue or
third party claims arising from the use of the software.

� Software specifications and the contents of the operation manual are subject to
change without prior notice.

� Operating speed may slow down depending on computer operating environment
and processing capability.

� This software is based in part on the work of the Independent JPEG Group.
� The software uses LEAD Tools Pro developed by Bunka Orient Corp. and Lead

Technologies, Inc.
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Foreword

This software is designed for presentations and for enhancement of
images projected from SHARP projectors. It includes the following
functions:

Projector Control Software:
Network Control
This function allows you to control the projector ’s functions/
adjustments from your PC.
A maximum of 250 projectors or grouped projectors can be controlled
from a central PC/CONTROLLER.
The Video Wall function, which normally requires expensive devices,
can be performed without purchasing additional hardware.
When the backup function is used, the projector standing by as the
backup projector automatically turns on if an error occurs in the other
projector(s).

Image Enhancement Software:
Gamma Correction
This function allows you to set the projector’s Gamma values directly
from your PC. The ease of specifying preset values enables precise
custom brightness, contrast and color adjustments.
Please note that this function can only be performed via a Network
(COM and LAN port).

Support Software for Presentations:
Presentation Transfer
This mode transmits BMP and JPEG images to the projector. By
saving presentation slides as BMP or JPEG images, you can do an
entire presentation wirelessly.

Capture & Transfer
This mode allows you to transmit an image currently displayed on
your monitor. As simple as clicking the “Capture & Transfer” button
in the application.

Quick Transfer
This mode is similar to “Capture & Transfer” but it can easily be used
by clicking the “Right” mouse button.

� Wireless image transfer can only be used with the XG-NV5/6/7.
Wireless image transfer cannot be used to transfer images with other
models.

� The following models do not support JPEG image transfer:
XG-P20X, XG-P25X, XG-V10X, XG-V10W.
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If you want to project your presentation slides saved as BMP or JPEG
files...

Presentation Transfer transfers images quickly &
easily in presentation format. (See page 82)

For Your Reference

There are five functions via the Network (COM and LAN port).

If you want to adjust image colors on the screen...

Gamma Correction controls the image colors via the
Network (COM and LAN port). (See page 76)

If you want to control the projector adjustments from your PC...

Network Control controls the projector adjustments
via the Network (COM and LAN port). (See page 24)
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If you want to project an image of what is currently displayed on your monitor...

Capture & Transfer captures the image on the PC
monitor and transfers it to the projector. (See page 86)

If you want to project a single image quickly...

Quick Transfer captures the image on the PC monitor
and transfers it to the projector using the mouse as a
shortcut. (See page 88)
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Required Hardware and Software

Sharp Advanced Presentation Software Professional Edition
requires the following hardware and software for operation.

PC running under Microsoft Windows 95, 98, NT4.0 Workstation,
Me, 2000 Professional, XP Home or Professional Edition
* Operations are confirmed with Japanese and English versions of those

Windows operating systems only.
CPU 233 MHz Pentium or higher is recommended.

Display A 800 × 600 dot display capable of displaying
65,536 colors or more

Memory 64 MB or more (Windows 95/98/NT4.0/Me/2000)
128 MB or more (Windows XP)

Hard disk free space 50 MB or more

Interface RS-232C serial port for transferring images and
controlling the projector

CD-ROM drive

Note that this software may not operate normally if the serial port settings,
etc., are not correct when serial equipment other than projectors is also
connected to the computer.

Using infrared communications (IrCOM)
If you use the NV5/6/7 projector, transferring images can be performed
using infrared communications (IrCOM). The PC requires a built-in infrared
communications port or an external infrared communications adapter.

� For Windows 95 users:
Microsoft IrDA 2.0 (Infrared Driver) must be installed on your PC
to use this software. If it is not installed, you can obtain it from
the Microsoft’s site on the Internet.

� For Windows 98 users:
Microsoft Windows 98 supports IrDA communications as a
default program.
Please consult to Microsoft operation manual for more details.

� For Windows NT4.0 Workstation, Me, 2000 Professional , XP Home
or Professional Edition users:
Infrared communications (IrCOM) cannot be used.

� The transmission speed of infrared communications is
dependent on the IrDA version of the PC.

• IrDA 1.0 : 9,600 bps - 115.2 kbps
• IrDA 1.1 : 4 Mbps

Therefore the actual speed depends on the IrDA version your PC
supports.
See the computer’s instruction manual for the IrDA specifications.

We cannot guarantee that the software will operate on computers whose
motherboards have been changed or modified, or on computers that
the users have configured themselves.
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Projector and PC Connections

This software requires the use of an RS-232C serial cable, LAN cable
or infrared communications. For details on PC connections, refer to the
projector’s operation manual.

CAUTION
Before connecting, be sure to turn both the projector and the computer
off. After making all connections, turn the projector on first. The computer
should always be turned on last.

� Please read the computer’s instruction manual carefully.
� If you use the NV5/6/7 projector, image transfer by using infrared

communications can be available.

Connecting Multiple Projectors with PC

When connecting multiple projectors using ID numbers
(when forming a network system consisting only of XG-V10
Series and XG-P20X and XG-P25X projectors)

PC

OUT

OUT

OUT

IN

IN

IN

IN

IN

OUT

IN

3F

2F

1F

B1

� The connection between PC and the Projector or the Projector and
the Projector is possible by using the projector’s RS-232C IN/OUT
terminal.

� Up to 250 projectors can be connected.
� Up to 99 COM ports can be used.
� Daisy chain connections are possible.
� LAN connections are possible only with models from the XG-V10

series with the optional extension board (AN-L10T) installed.
� See “Table of Functions by Model” (page 92) about the projector’s

available functions.
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When connecting multiple projectors without using ID
numbers (When forming a network including projectors other
than the XG-V10 Series and XG-P20X and XG-P25X
projectors)

PC IN

IN

IN

PCPC
3F

2F

1F

� Up to 99 projectors can be connected.
� Up to 99 COM ports can be used.
� Daisy chain connections are not possible.
� LAN connections are not possible.
� See “Table of Functions by Model” (page 92) about the projector’s

available functions.

Connect one projector per COM port.
If you want to use the connection via the COM ports, the same number
of COM ports as the projectors is needed. If the number of COM ports
built in your PC is less than the number of projectors, purchase the
extension board (commercially available) to add COM ports to your PC.

Connecting Single Projector with PC

RS-232C connection
Refer to the
projector’s operation
manual for details.

Optional RS-232C cable (cross type)
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Installing the Software

This software can be installed using the installation program supplied
on the “Sharp Advanced Presentation Software Professional Edition
CD-ROM”.

1 Make sure that this software is suited for your computer.
For details, refer to “Required Hardware and Software” (page 9).

2 Quit all running applications before installing this
software.
Be sure to quit all other applications so that no problems occur with
the installer.

3 Delete the previous version of the Sharp Advanced
Presentation Software.
For details, refer to “Uninstalling the Software” (page 19).

4 Insert the “Sharp Advanced Presentation Software
Professional Edition CD-ROM” in the CD-ROM drive.

5 Double click the “My Computer” icon or select Windows
Explorer.

6 Double click the CD-ROM drive icon in the “My Computer”
or in Windows Explorer.

7 Double click the “SAPS_PRO” folder.

8 Double click the “SETUP1.EXE” icon.
| The “Sharp Advanced Presentation Software Professional

Edition” Opening Image will be displayed.
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9 Select the language of the software to be installed.

Select a language appropriate for your computer’s environment.

| The “Sharp Advanced Presentation Software Professional
Edition” dialog box will open.
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10 Click “Next>”.
| The “Choose Destination Location” dialog box will open.

11 The folder under which the software will be installed is
displayed in “Destination Folder”.

To select another folder, click “Browse...”.

12 Click “Next>”.
| “Auto-Launch Setup” dialog box will open.
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13 Click “ON” under “Auto-Launch” to automatically launch
the software every time you start your PC. (Recommended)

If you set “Auto-Launch ON”, a “Sharp Advanced Presentation
Software Professional Edition” icon will appear in the Windows
task tray. If not, use the “Sharp Advanced Presentation
Software Professional Edition” shortcut icon on the desktop or
the Windows “Start” menu.

14 Click “Next>”.
| Installation will start.

| When the installation is completed, the “Setup Complete” dialog
box will open. To use the program immediately, please restart
your computer.

15 Click “Finish”.
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Setting up your PC for Infrared Communications (IrCOM)

If you use the NV5/6/7, image transfer can be performed using infrared
communications (IrCOM).
To use infrared communications, set the PC’s port for infrared
communications according to the following steps.

Infrared communications (IrCOM) cannot be used with Windows NT4.0
Workstation, Me, 2000 Professional, XP Home or Professional Edition.

1 Click “Start”, and then click “Settings”, then select
“Control Panel”.
| The “Control Panel” window will open.

2 Double click the “Infrared” icon.

| The “Infrared Monitor” window will open.

For Windows 95 users:
If an “Infrared” icon is not displayed the Microsoft IrDA 2.0 (Infrared
Driver) is not installed on the computer.
You can obtain it from the Microsoft’s site on the Internet.
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3 Click the “Options” tab.
| The “Options” sheet will open.

4 Check the “Enable infrared communication” check box.
Select the port used for infrared communications.

Refer to the PC’s instruction manual for the appropriate port settings.
Do not check the “Search for and provide status for devices within
range” and “Limit connection speed to” check box.
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5 Click the “Preferences” tab.
| The “Preferences” sheet will open.

6 Click “Restore Defaults”.
The system will return to standard settings.

7 Click “OK”.
| The “Infrared Monitor” window will close and the “Infrared”

icon will appear in the Windows task tray.

Infrared icon

About the “Infrared” icon

 Enable: Ready to transfer

 Disable: Not ready to transfer
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Uninstalling the Software

Always uninstall Sharp Advanced Presentation Software Professional
Edition, when installing a new or updated version.

1 Make sure that the software is closed before proceeding.

Before uninstalling Sharp Advanced Presentation Software
Professional Edition, the “Auto-Launch” setting must be “OFF”.
For details, see page 22.

2 Click “Start”, then click “Settings”, and then select
“Control Panel”.

3 Double click the “Add/Remove Programs” icon.

4 Click the “Sharp Advanced Presentation Software
Professional Edition”.

5 Click the “Add/Remove...”.

6 Click the “Yes”.

7 When uninstallation is correctly completed, “Uninstall
successfully completed” will appear. Click “OK”.
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Starting and Quitting

Opening Modes

Before starting the software, make sure that the projector and the PC are
correctly set up. There are three ways to start up the software.

Starting from the “Sharp Advanced Presentation Software
Professional Edition” icon in the Windows task tray

This icon appears when “Auto-Launch ON” is selected. See page 22
for “Auto-Launch” setting.

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turned on last.

The projector must be in IrCOM mode to receive the images. Press
the “IrCOM” button on the projector or the remote control.
For NV5/6/7 users:
To use infrared communications, select the “IrCOM” mode, referring
to the projector operation manual for details.

2 Start up the PC. Click the “Sharp Advanced Presentation
Software Professional Edition” icon in the Windows task
tray.
| The “Sharp Advanced Presentation Software Professional

Edition” window will open.

Starting from the Windows “Start” button

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turned on last.

The projector must be in IrCOM mode to receive the images. Press
the “IrCOM” button on the projector or the remote control.
For NV5/6/7 users:
To use infrared communications, select the “IrCOM” mode, referring
to the projector operation manual for details.
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2 Start up the PC. Click the “Start” button, set the pointer
to “Programs” and then “Sharp Advanced Presentation
Software Professional Edition”.
| The mode dialog box will open.

Starting from the “Sharp Advanced Presentation Software
Professional Edition” shortcut icon on the Windows desktop

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turned on last.

The projector must be in IrCOM mode to receive the images. Press
the “IrCOM” button on the projector or the remote control.
For NV5/6/7 users:
To use infrared communications, select the “IrCOM” mode, referring
to the projector operation manual for details.

2 Double click the “Sharp Advanced Presentation Software
Professional Edition” shortcut icon on the Windows
desktop.
| The mode dialog box will open.

Selecting the Main Projector Model

1 Select the main projector model you want to use.

This dialog box appears the first time you start the “Sharp Advanced
Presentation Software Professional Edition”.
If you want to change the projector model, you can change it on the
“Projector Setting” dialog box (page 28).
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Changing the Auto-Launch Setting

The default “Auto-Launch” setting is “ON”. This automatically starts
the software when the PC starts up. You can change the setting as
follows.

1 Click the “Option” menu, and select “Auto-Launch ON/OFF”.

2 Select the setting as required.

When “Auto-Launch ON” is selected
� The “Sharp Advanced Presentation Software Professional

Edition” icon is displayed in the Windows task tray.
� The software is automatically launched when the PC starts up.

When “Auto-Launch OFF” is selected
� The “Sharp Advanced Presentation Software Professional

Edition” icon is removed from the Windows task tray.
� In this case the software must be started from the “Start” menu or

the “Sharp Advanced Presentation Software Professional
Edition” shortcut icon on the Windows desktop.

Selecting the Mode

1 Start up the projector.

2 Select the mode you require from the “Mode” menu. Or
you can use the shortcut buttons below the menu bar.

Gamma
Correction

Single
Control

Presentation
Transfer

Capture &
Transfer

Multiple
Control

Video Wall
Setting

| The mode dialog box will open.

The selectable modes depend on the operation mode set at “Selecting
the Operation Mode” (page 25).
For details, refer to the “Table of Functions by Model” (page 92).
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Quitting

Click the “File” menu, and select “Exit”.
Or you can use the  button.

Help

To view Help, click the “Help” menu. When the “Help” window opens,
click the desired item in the Help list.

To check the software version, select “About This Software” from the
“Help” menu.
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Scan Setting (page 26) Projector Setting (page 28)

Setting whether to control
a single projector or multiple
projectors (page 25)

Setting whether or not to use
IDs to control projectors (page 25)

Create the “All Projector List”
(list of projectors to be controlled).

Create the “All Projector List”
(list of projectors to be controlled).

To use IDs

To not use IDs

Create the “All Projector List”
automatically.

Create/add to the
“All Projector List” manually.

To control multiple projectors

To control a single projector

Setting the number of
projectors to be controlled

Create the “All Projector List”

Create the “All Projector List”

Setting whether
or not to use IDs

Setup for Controlling the Projectors

The settings for the projectors must first be made in the software before attempting to control
any projector. Settings are made in “Scan Setting” or in “Projector Setting”.

The settings for the ID numbers on the projector are needed to control the projector by
using the ID numbers.

Setup flowchart

From the following pages onwards,  Single  and/or  Multi  are displayed at the top of the page.
Single: Functions used when the projector is used in “Single Projector Operation Mode.”
Multi: Functions used when the projectors are used in “Multiple Projector Operation Mode.”
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Selecting the Operation Mode

1 Select “Operation Mode Setting” from the “File” menu.

2 Select the Operation Mode.

� To operate a single projector, select “Single Projector Operation
Mode”

� To operate multiple projectors, select “Multiple Projector Operation
Mode”, then choose “Use ID Number” or “Don’t Use ID Number”.

� When “Don’t Use ID Number” is selected for “Multiple Projector
Operation Mode”, up to 99 projectors can be operated at once. Models
other than the XG-V10 Series, the XG-P20X or the XG-P25X projector
can be used.

� When “Use ID Number” is selected for “Multiple Projector Operation
Mode”, up to 250 projectors can be operated at once. If selecting
“Use ID Number”, only the XG-V10 Series, the XG-P20X or the XG-
P25X projectors can be used.

� A computer with high processing capability is required to use the
“Multiple Projector Operation Mode”. We recommend using the
“Single Projector Operation Mode” to control a single projector.
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Multi

Scan Setting

This function allows the software to automatically identify and control all
the projectors connected to the PC without having to the ports and
models. To use this function, the COM ports and IP address to be scanned
with “Scan Setting” must be set beforehand.
For details and setting of “Scan Setting” see below.

1 Select “Scan Setting” from the “File” menu.
Set the projectors to be scanned here.

1 COM port enable/disable check box

The serial number is assigned when using multiple connections
which do not use IDs.

2 Set the COM port Transmission Speed.
3 IP address input area
4 List of input IP addresses and enable/disable check box
5 Add button

When clicked after inputting the IP address, the address is added to
the list in 4.

6 Delete button
When clicked after selecting the IP address in 4, that address is
deleted.

7 List of projectors whose IDs are redundant.
8 List of projectors whose IDs are missing.
9 Scan button
0 OK button
q Cancel button

1

8

5 6 9 0 q

7

2

4

3
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2 Set the port to which the projector is connected.
� In 1, check the check box of the COM port to which the projector

is connected.
� To use a LAN, input the IP address in 3, click the “Add” button,

then check the check box in 4.

LAN connections are possible only with models from the XG-V10
series with the optional extension board (AN-L10T) installed.

3 Click the “Scan” button.
The connected projectors are identified.

� If projectors with the same IDs are discovered through scanning,
the data for those projectors is displayed in the “Redundant” area.
If this happens, reassign suitable IDs to the projectors.

� The results of scanning are compared with the pre-scanning All
Projector List and the data for projectors that could not be
confirmed as being connected is displayed in the “Missing” area.

4 Click “OK” if you wish to create an “All Projector List”
based on the results of scanning.
If you do not wish to create an “All Projector List”, click “Cancel”.

Deleting the set IP address

1 Select the IP address to be deleted in 44444.

2 Click the “Delete” button.
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Projector Setting

When “Multiple Projector Operation Mode (Use ID Number)” is selected
in “Operation Mode Setting”, it is possible to add projectors manually
without using the scan setting automatic identification function. In
addition, when “Multiple Projector Operation Mode (Don’t Use ID
Number)” or “Single Projector Operation Mode” is selected, make the
respective settings at “Projector Setting”.

Multiple Projector Operation Mode

1 From the “File” menu, select “Projector Setting”.

1 Select the ID number.
2 Select the port.
3 Select the transmission speed.
4 Input the IP address.
5 Enable/disable check box
6 Select the projector model.
7 Backup function enable/disable check box
8 Backup projector selection pull-down menu
9 Apply button.

2 Select the ID number.
If selecting “Don’t use ID Number” in “Operation Mode Setting” (page
25), you don’t need to select the ID number here.

3 Select the port to which the projector is connected.
If using the RS-232C connection, select a COM port to be used from
“Port” pulldown menu.
If using the LAN connection, select “LAN”.

LAN connections are possible only with models from the XG-V10
series with the optional extension board (AN-L10T) installed.

1 2

3

4

5

6

8

7

9
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4 Set the Port Status.
If using the RS-232C connection, select the transmission speed
between the computer and the projector.
If using a LAN connection, input the projector’s IP address.

� Set the transmission speed here and confirm the transmission speed
on the projector to the same speed.

� For instructions on the projector’s transmission speed setting, refer
to the projector’s operation manual.

5 Select the projector model and check the “Use Projector”
check box.

6 Set the backup projector.
If necessary, set the backup projector.  See page 56 for details.

7 Click the “Apply” button.



30

Single

Single Projector Operation Mode
(For the connection via RS-232C or IrCOM)

1 From the “File” menu, select “Projector Setting”.

1 Area for selecting the connection type
2 Area for selecting the projector model
3 Area for COM port setup

2 Select the projector model.

3 Select “RS-232C” or “Wireless (IrCOM)” in “Connection
Type”.
� The following image is displayed when the RS-232C connection

is selected.

� The following image is displayed when the Wireless (IrCOM)
connection is selected.

For the connection via IrCOM, only the NV5-7 projectors can be used.

4 Select the “COM” port to which the projector is connected.

2

3
1
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5 Select the transmission speed between the computer and
the projector.

� Set the transmission speed here and confirm the transmission speed
on the projector for the same speed.

� For instructions on the projector’s transmission speed setting, refer
to the projector’s operation manual.

6 Click the “OK” button.

Single Projector Operation Mode
(For the connection via LAN)

1 Repeat steps 1 and 2 in “Single Projector Operation Mode
(For the connection via RS-232C or IrCOM)” (page 30).

2 Select “LAN” in “Connection Type”.

3 Input the IP Address.

4 Click the “OK” button.

LAN connections are possible only with models from the XG-V10 series
with the optional extension board (AN-L10T) installed.
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Controlling Multiple Projectors

Multiple Control

This is a function for controlling multiple connected projectors (see page
10) from your computer. Depending on the connections, up to 250
projectors can be controlled.

1 Repeat steps 1-2 on “Selecting the Operation Mode” (page
25).

2 Select “Multiple Control” from the “Mode” menu or click
the  icon on the menu bar.
| The Multiple Operation Panel will open.

All Projector: Area for controlling all the connected projectors.

1 Select the Power ON/OFF
2 Select “AV Mute” ON/OFF

The mute and black screen functions are conducted
simultaneously.

3 To make “Black Screen” ON/OFF
4 Select “Mute” ON/OFF

CAUTION
If the power of all the projectors is turned on at once, the power capacity
in the facilities may be exceeded. To avoid this, this software is equipped
with a function for making a setting for turning on the power of the
projectors one at a time.

7
8
9
0
w
e
rq

t

5
6

1 2
3
4

y
u
i



33

A
d

ju
stin

g
 an

d
C

o
n

tro
llin

g
Multi

1 From the “Control Option” menu, select “Configuration”.

2 Select “ALL” if you want to turn on all the projectors at
once or “Delayed” if you want to turn on the projectors
one at a time in order.

3 Click the “OK” button.

Group Projector: This is for controlling grouped projectors one group
at a time. The adjustment items in this frame are
reflected for all the projectors in the selected group.

5 Select the Power ON/OFF
6 Select the “Input Mode” from RGB1 to 3, or Video 1 to 2.
7 To make “Volume” adjustment

The volume of the projector with the lowest ID number in the group
is displayed.

8 Select “AV Mute” ON/OFF
9 To make “Black Screen”
0 Select “Mute” ON/OFF
q Group List : Displays a list of all the connected groups.

The information displayed in “Group List” is as follows:
� Power : When the power supplies of all the projectors

belonging to the group are ON, the green icon
is displayed. When they are OFF, the red icon is
displayed.
When the power supplies of some projectors are
ON and others are OFF, the yellow icon is
displayed.

� No : Group Number
� Group : Group Name
� Input Mode : Selected Input Mode
� Vol : Volume

In “Input Mode” and “Vol”, the value of the projector whose ID
Number is the smallest of all the projectors belonging to the group,
is displayed.
(When controlling the projectors without using an ID Number,
the value of the projector whose COM Port Number is the smallest
in the group is displayed.)

w Refresh all the display information.
e Refresh the display information for the selected group.
r Jump to “Advanced Control for Adjustment” to conduct adjustments

for the selected group.
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All Projector List: All the identifiable connected projectors are listed
here.

t All Projector List: Displays a list of all the identifiable connected
projectors.

The information displayed in “All Projector List” is as follows:
� Power : When the power supply of a projector is ON, the

green icon is displayed. When it is OFF, the red
icon is displayed. (For a projector assigned as a
backup, “B” is attached to the icon.)
When an error occurs in a projector, an “!” mark is
displayed.

� Projector : Projector Name
� ID : ID Number
� Port : Port the projector is connected to (COM or LAN)
� Group : Group Name the projector belongs to
� Input : Selected Input Mode
� Lamp : Accumulative usage time of a lamp (when more

than two lamps are used, the accumulative usage
time of the longest used lamp is displayed) or
remaining lamp life in percentage.

� Status : Status of a projector
� Vol : Volume
� Info : Resolution or signal type of a projected image
� COM : Transmission status (“OK” or “ERR”)
� Backup : When another projector stands by as a backup

projector, the ID Number, Port and Projector Name
of the backup projector are displayed. When a
projector is assigned as the backup of another
projector, the ID Number, Port and Projector Name
of the projector which is backed up is displayed.

y Refresh all the display information
u Refresh the displayed information for the selected projector with

the most recent information.
i Jump to “Advanced Control for Adjustment” to conduct adjustments

for the selected projector.

Some items may not be displayed, depending on the type of projector.
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Group Setting

Individual projectors not belonging to groups can be added to groups,
and projectors belonging to groups can be removed from groups.

1 Select “Group Setting” from the “Control Option” menu.
| The “Group Setting” dialog box will open.

1 List of available projectors
Not displayed when projector names have not been set.

2 Select Group No.
3 Input Group Name.

32 characters can be input at maximum.
4 List of assigned projectors
5 Right arrow

Adds the projector selected in the list of connected projectors to the
group.

6 Left arrow
Removes the projector selected in the list of projectors belonging to
the group from the group.

7 Clears all the projectors belonging to the selected group.
8 Applies the setting.
9 Cancels the setting.

2 Select the group to be registered in the Group Number
and Group Name input area.

3 Select the projector in the list of available projectors.

4 Click the right arrow button.
The selected projector is displayed in the list of assigned projectors.

2

1

5

6

7
8
9

3

4



36

Multi

5 Click “OK”.

One projector can be assigned to only one group at a time.

To remove projectors belonging to groups from the group

1 Select “Group Setting” from the “Control Option” menu.
| The “Group Setting” dialog box will open.

2 Select Group No. by clicking \ / |.

3 Select the projector in the list of projectors belonging to
the group.

4 Click the left arrow button.
The selected projector is removed from the list of projectors belonging
to the group.

To remove all the projectors belonging to a group, click the “Reset” button
after selecting the group number in step 2.

To delete a group

1 Select “Group Setting” from the “Control Option” menu.
| The “Group Setting” dialog box will open.

2 Select Group No. by clicking \ / |.

3 Click the “Reset” button.

4 Delete the group name displayed in the Group Name input
section.

5 Click “OK”.
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Password Setting

This function protects the Keylock Level and the Unique Name from
changes by other users.

This function works with the following models:
PG-C30X, PG-C45 Series, XG-C40X, XG-C50X, XG-P10X, XG-P20X,
XG-P25X, XG-V10 Series.

Setting the Password

1 From the “Control Option” menu, select the “Password”.
The “Set Projector Password” dialog box will open.

2 Enter a 4-digit password using the keyboard into “New
Password” in the “Set Projector Password” dialog box.
When using the Multiple Projector Operation Mode, select the “ID
number” or “COM port number” before performing the above
operation.
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3 Enter the 4-digit password using the keyboard into
“Reconfirm” on the “Set Projector Password” dialog box.
Check the “Save Password” check box if you want to save the password.

4 Click “OK”.

After setting the password, be sure to write it down in a secure location
so as not to forget it.
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Changing the Password

1 From the “Control Option” menu, select “Password”.

2 Enter the 4-digit old password using keyboard into “Old
Password” on the “Set Projector Password” dialog box.
When using the Multiple Projector Operation Mode, select the “ID
number” or “COM port number” before performing the above
operation.

3 Enter the 4-digit new password using keyboard into the
“New Password” and “Reconfirm” on the “Set Projector
Password” dialog box.
Check the “Save Password” check box if you want to save the
password.

4 Click “OK” .

The password setting is canceled when “OK” is clicked if nothing is
entered into the “New Password” and “Reconfirm” area.
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Selecting the Keylock Level

This function can be used to lock the use of certain operation buttons on
the projector.

1 From the “Control Option” menu, select “Keylock Level”.
| The “Keylock Level” dialog box will open.

1 Select the ID number/COM Port number.
2 Keylock Level selection area
3 Password Input area

2 Select the Keylock level from “Normal”,”Level A” or “Level
B”.
When using the Multiple Projector Operation Mode, select the “ID
number” or “COM Port number” before performing the above
operation.
See the diagram on the next page for the description of Keylock
Levels.

3 Input the password.
When the password has been set in the projector, the “Password
Input area” is displayed. Once displayed, enter the password.

1

2

3
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4 Click “OK” or “Apply”.

Description of Keylock Levels

The projector can still be fully operated with either the remote or this
software while using the Keylock function.

Selected item Description

Normal

Level A

Level B

All operation buttons are functional.

Only INPUT, VOLUME, MUTE on the projector are
available.

All operation buttons on the projector are unavailable.
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3

Projector Name and Unique Name Setting

Names can be given to multiple connected projectors using IDs. When
giving names, it is possible to select “Unique Name” with a password or
“Projector Name” without a password.

1 Select “Projector/Unique Name” from the “Control Option”
menu.
| The “Projector Name & Unique Name” dialog box will open.

1 Select the ID number/COM Port number.
2 Projector Name Input area

A maximum of 12 caracters can be entered.
If already set, the set projector name is displayed.

3 Unique Name Input area
A maximum of 12 caracters can be entered.
If already set, that unique name is displayed.

4 Password Input area

2 Select the Projector ID by clicking ".

3 Input the new name in the “Projector Name Input area” or
“Unique Name Input area”.

4
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4 Input the password.
When the password has been set in the projector, the “Password
Input area” is displayed. Once displayed, enter the password.

5 Click “OK” or “Apply”.

� The “Projector Name” is a name for facilitating identification of the
individual projectors when controlling multiple projectors.  We
recommend entering the projector’s model name, the place where it
is installed, etc., in “Projector Name”.

� The “Unique Name” does not affect projector control.  It is protected
by the password set on page 37. (Only those who know the password
can change it.)
We recommend inputting the name of the projector’s owner, etc., at
“Unique Name”.
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E-mail Sending Function

This software makes it possible to automatically send an e-mail message
containing information concerning errors to a preset e-mail address
should projector errors be detected. In addition to automatically sending
e-mail messages when errors arise, it is also possible to periodically
send e-mail messages containing information on the projector status.

� The PC setting for e-mail (e.g., LAN connection setting or Dial-up
connection setting) at first is needed to use this function.

� The information is attached to the e-mail messages as files in CSV
format.

� This function can only be used when this software is running on a
personal computer.

� This e-mail is sent by connecting to the server through an SMTP
(Simple Mail Transfer Protocol).

Sender Setting

Make the e-mail sender’s settings here.

1 E-mail (SMTP) server name input area
2 Sender e-mail address input area
3 Sender name input area
4 Sender information input area

1

2

3

4
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Sender settings

1 Input the E-mail (SMTP) server name to be used when
sending e-mail in the “E-mail (SMTP) server name input
area”.

2 Input the sender’s e-mail address in the “Sender e-mail
address input area”.

3 Input the e-mail sender’s name in the “Sender name input
area”.

4 Input information concerning the sender in the “Sender
information input area”.

5 Click the “OK” button.

� The E-mail (SMTP) server name and e-mail address may vary
depending on your network environment. Consult your Network
Administrator for details.

� You can enter any name for Sender Name in “Sender name input
area” or any details for Sender Information in “Sender information
input area”.
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E-mail Address Book Setting

Make here the settings for the “Projector Condition” e-mail messages
(for sending periodic e-mail messages on the projector status) and the
“Projector Error” e-mail messages (for notifying that errors have
occurred).

E-mail message recipient address setting

1 Select “E-mail Address Book” from the “Control Option”
menu.

1 The Enable/Disable check boxes.
If the Enable/Disable check boxes have been selected, e-mail will be
sent to the address entered in 2

2 E-mail recipient list
3 Recipient name input area

Enter the name of the recipient
4 Recipient e-mail address input area

1

3

2

4
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Registering the recipient’s e-mail address

1 Click the number you want to register as the new recipient
e-mail address.

2 Enter the name of the recipient in “Recipient name input
area”.

3 Enter the e-mail address of the recipient in “Recipient e-
mail address input area”.

4 Click the “Apply” button.
The e-mail address is added to the “E-mail recipient list”.
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Specifying the recipient’s e-mail address

1 Select the check box of the e-mail address you want to
specify as the recipient.

2 Click the “Apply” button.

Changing the registered recipient’s e-mail address

1 Click the e-mail address you want to change.

2 Enter the new information in “Recipient name input area”
or “Recipient e-mail address input area”.

3 Click the “Apply” button.
The new name or e-mail address is displayed.
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Deleting the registered recipient’s e-mail address

1 Select the e-mail address you want to delete.

2 Clear the check box if there is a check mark in it.

3 Use the “Delete” key on the Keyboard to delete all
information in “Recipient name input area” or “Recipient
e-mail address input area”.

4 Click the “Apply” button.
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Send E-mail Setting

Set here the timing at which e-mail messages are to be sent and the
information to be attached to the e-mail messages.

1 Area for selecting whether or not to send e-mail messages
automatically

2 Area for setting the timing at which periodic e-mail messages are to
be sent

3 Area for setting additional attached information
4 Button for sending “Projector Condition” e-mail messages manually

1

2

3

4
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Automatic e-mail sending function settings
� If you wish e-mail messages to be sent automatically when projector

errors occur: Select “Error Occurrence”.
� If you do not wish e-mail messages to be sent automatically, select

“Not Send E-mail”.

The information sent when errors occur is as follows:

DATE : Date e-mail sent
TIME : Time e-mail sent
ID : Projector ID number
PORT : Port to which projector is connected
GROUP : Name of group to which projector belongs
MODEL : Projector’s model name
S/N : Projector’s serial number
ERROR : Type of error

� In the above information, the content displayed varies depending
on the model.

Periodic e-mail sending function settings

1 If you wish e-mail messages on the projector’s conditions
to be sent automatically, check the “Optional Timing”
check box.

2 Select the timing at which e-mail is to be sent.
Select one of the following four timings:
“Every day”, “Every week”, “Every two weeks” or “Every month”.
If “Every week” or “Every two weeks” is selected, also select the day
of the week. If “Every month”, also select the day of the month.

3 Set the time at which the e-mail messages are to be sent.

The information sent when errors occur is as follows:

DATE : Date e-mail sent
TIME : Time e-mail sent
ID : Projector ID number
PORT : Port to which projector is connected
GROUP : Name of group to which projector belongs
MODEL : Projector’s model name
S/N : Projector’s serial number
CONDITION : Projector’s status
LAMP : Accumulated lamp usage time or remaining

lamp life in percentage
TEMP_AVR. : Projector’s average internal temperature

� In the above information, the content displayed varies depending
on the model.
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Settings for additionally attached files
By making the settings described below, it is possible to attach files
containing information on individual projectors in which errors have
occurred and files containing information on the user settings of all
connected projectors in addition to the CSV files that are attached to the
periodically sent e-mail messages.

� When the “Temp” check box is checked, a CSV file containing
information on projectors whose internal temperatures are high is
attached.

� When the “Fan” check box is checked, a CSV file containing
information on projectors whose internal cooling fans present some
sort of irregularity is attached.

� When the “Filter Cover” check box is checked, a CSV file containing
information on projectors whose filter covers are not mounted properly
is attached.

� When the “Lamp” check box is checked, a CSV file containing
information on projectors whose light source lamps present some
sort of irregularity is attached.

� When the “Communication” check box is checked, a CSV file
containing information on projectors for which communication with
the computer is not possible is attached.

� When the “Control Setting Data” check box is checked, a data file
containing all the user settings (“Contrast”, “Input select”, etc.) is
attached. (The user settings are the same as the settings obtained
using the “Save Control Setting” function. The file has the extension
“lcd”.)

Sending the “Projector Condition” e-mail message
manually

Click “Send E-mail” to send an e-mail message containing information
on the projector conditions manually.
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Error Notification Function

This software is equipped with a function for automatically notifying the
computer running the SAPS software with error information when an
error arises with the projector.

If a major error arises, a warning window is displayed, as shown below.

When the “Help” button is clicked, the “Help” window opens.

� The Occurrence and Timing settings can be customized at “Send
E-mail Setting” (page 50). Projector information is then forwarded
either when problems arise or periodically according to the
configuration.

� If your projector is an XG-V10 Series, the XG-P20X or the XG-P25X
projector, a warning window is immediately displayed whenever errors
occur.

� If your projector is a model other than the XG-V10 Series, the XG-
P20X or the XG-P25X, some time (up to about 3 minutes) is required
from when the error occurs until the warning window is displayed.
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Projector Timer Control

This function is for turning off the projector’s power at a preset time.

� This function can only be used when this software is running on a
personal computer.

� This function manages the time based on the computer’s built-in clock,
so it will not operate properly if the computer’s clock setting is incorrect.

1 Select “Projector Timer Control” from “Control Option”.
The “Projector Timer Control” dialog box will open.

1 Enable/disable check box
2 List of all connected projectors

2 Click on the projector for which you want to set the timer.

Multiple projectors can be selected by pressing the keyboard’s control
or shift key while selecting the projectors.

3 Click “Setting OFF Timer”.
The “Projector Timer Control” dialog box will open.

1 Enable/disable check box

1

2

1



55

A
d

ju
stin

g
 an

d
C

o
n

tro
llin

g
Multi

4 Set the time you want the timer to turn off.

5 Check the “Enable/disable check box”.

6 Click “OK”.
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Backup Function

This function automatically turns on the projector assigned in advance
as the backup projector, when the projector goes into standby due to a
malfunction.
When the backup projector autostarts, the settings of the projector in
which the error occurred are suitably sent to the backup projector,
therefore the interruption of the presentation is reduced to a minimum.

� This function can only be used when this software is running on a
personal computer.

� This function can only be used with the XG-V10 Series, the XG-P20X or
the XG-P25X.

� The backup projector will restart in the event of the following errors.
• Internal temperature error
• Cooling fan error
• Filter cover error
• Lamp burnout error

� The settings sent from the projector in which the error occurred to
the backup projector are as follows:
• The selected INPUT
• Signal Type information (RGB/COMPONENT/VIDEO)
• RESIZE information (Aspect ratio)
• Special Mode information
• Video System information

� Assign a projector that is normally in the standby mode as the backup
projector. Note that images other than the ones you expect may be
displayed when the backup function is activated if a projector that is
normally used is accidentally assigned as the backup projector.

Backup Function Settings

1 Select “Projector Setting” from the “File” menu.

1 Backup function enable/disable check box
2 Backup projector selection pull-down menu

1

2
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2 Make the settings for the projector for the side to be
backed up.
Refer to page 58 to make the settings for the projectors to be backed
up.

3 Check the “Backup function enable/disable check box”.

4 Select the projector to be assigned as the backup projector.
Select the projector from the projector selection pull-down menu.

5 Click the “Apply” button.

Interval Time Setting

With this software, the projectors’ internal data is collected periodically at
preset intervals so that the backup function can work. Set this interval here.

1 Select “Configuration” from “Control Option”.

2 Select the desired interval in “Backup interval” on the
“Configuration” window.

3 Click the “OK” button.

When several projectors have been set to be backed up, the data of
one projector will be collected in order at each backup interval that
is set in advance.
For example, if the backup interval has been set to 5 minutes and 3
projectors have been set to be backed up, the data of the first
projector will be collected. After 5 minutes have elapsed, the data of
the second projector will be collected. Again after 5 minutes, the
data of the 3rd projector will be collected. 5 minutes later, the data of
the first projector will be collected again and the data collection
procedure will repeat itself as above.
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OUT

IN

PC

Do not assign a 
projector that is far 
from the computer 
as the backup 
projector.

Assign a projector that is 
closer to the computer as 
the backup projector.

IN

Recommended connections for using the backup function
� When using the backup function, we strongly recommend connecting

the projectors to separate ports rather than in a daisy chain as shown
on the diagram below.

� When the projectors are connected in a daisy chain, assign a projector
that is closer to the computer as the backup projector, as shown on
the diagram below. (The backup function may not work properly if a
projector that is far from the computer is assigned as the backup
projector.)

PC

IN

IN

COM1

COM2

Use different ports for the projectors to be 
backed up (normally used projectors) and 
the projector assigned as the backup 
projector (a projector normally in the 
standby mode).
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Resetting after the backup function has been activated
If a problem occurs with a projector and the backup function has been
activated, use the procedure described below to eliminate the problem
with the projector and reset the backup function.

1 Select the projector in which the problem occurred at
“Projector Setting”.

2 Clear the “Use Projector” check box, then click the
“Apply” button.
The “Backed Up By” check box is automatically cleared at
this time.

3 Eliminate the problem with the projector.

4 After the problem is eliminated, select that projector in
“Projector Setting” and select “Use Projector”.

5 Check that a suitable projector is selected as the backup
projector, then select the “Backed Up By” check box.

6 Click the “Apply” button.
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Controlling the Projector’s Adjustment

Advanced Control for Adjustment

This function enables you to control the individual projector adjustments
from your PC.
Refer to the projector’s operation manual for details on each adjustment.

� Adjustments can still be made from the Advanced Control for
Adjustment utility regardless of the difference in settings in the
projector’s menu.

� If you move to Advanced Control for Adjustment during Presentation
Transfer, Capture & Transfer or Gamma Correction, Sharp
Advanced Presentation Software Professional Edition automatically
confirms the adjustments on the projector and shows them in the
Advanced Control for Adjustment window as default settings.

� Also when you change the sheet of the Advanced Control for
Adjustment window to proceed to the other projector adjustment,
this confirmation is performed. In this case, it will repeat at regular
intervals afterwards and the Advanced Control for Adjustment
window may show the settings on the projector.

� The Automatic Power Shutoff function will not operate when performing
Advanced Control for Adjustment, although you turn “Auto Power
Off” ON in the “Options” sheet. This function operates during
Presentation Transfer, Capture & Transfer, or Gamma Correction.
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Multiple connections

1 Select individual or group projectors you want to control
on the Multiple Operation Panel.

2 Click “Multiple Control” on the Multiple Operation Panel.
| The “Multiple Control” window will open.

3 Select the projector which you want to control.
� You can select all connected projectors or individual projectors

when “All connected projectors” is selected in the “Group” pull
down menu.

When you select “All connected projectors” in the the “Group” pull down
menu, “All” and the list of all connected projectors are enumerated in
the “Single” pull down menu.
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� You can select all or individual projectors belonging to a group, when
“Group A*” is selected in the “Group” pulldown menu.

When you select “Group A*” in the “Group” pulldown menu, “All” and the
list of all projectors which belong to “Group A” are enumerated in the
“Single” pull down menu.
* You can select other projector groups not only Group A but also Group

B, C, etc..

4 Click the tab of the sheet that includes your desired
adjustment controller.

Single connection
1 Select the “Single Control” mode.

See section “Opening Modes” (page 20).
| The “Single Control” window will open.

2 Click the tab of the sheet that includes your desired
adjustment controller.
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Basic Operation of the Adjustment Sheet

Button icon

You can set the adjustment item by clicking the button icon (Eg; “Power
ON/OFF”,  “Auto Sync”,etc.).

Pull down menu

You can set the adjustment item by selecting the desired setting from
the pull down menu (Eg; Gamma, etc.).

Slide bar

You can adjust the item by dragging the slide bar or entering the
desired value (Eg; Contrast, etc.).

Sending all adjusted data on the sheet to the projector.

Click the “Send” button to control all the adjustments on the sheet.

Receiving the adjusted data from the projector

Click the “Receive” button to confirm the adjustments on the projector.
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“Set Up” Adjustment

E. g. The display below is the one that appears when used with the XG-
C50X projector.

You can perform the adjustments, settings or functions below on this
sheet.
Power ON/OFF, Input Select Gamma, Focus, Keystone, Lens Shift,
Digital Shift, Zoom, V-Size, Black Screen ON/OFF, Auto Sync,
Freeze ON/OFF

� Some items may not be controlled depending on the projector
model to be controlled.

� Refer to the projector’s operation manual for details on each
adjustment.
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“Input PICT” Adjustment

E. g. The display below is the one that appears when used with the XG
C50X projector.

You can perform the adjustments, settings or functions below on this
sheet:
Contrast, Bright, Red, Blue, Color Temp, Color, Tint, Sharp, Signal
Type, Resize, Progressive Mode

� Some items may not be controlled depending on the projector
model to be controlled.

� Refer to the projector’s operation manual for details on each
adjustment.
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“Fine Sync” Adjustment

E. g. The display below is the one that appears when used with the XG-
C50X projector.

You can perform the adjustments, settings or functions below on this
sheet:
Clock, Phase, H-POS, V-POS, Auto Sync Setup ON/OFF, Special
Modes, Auto Sync Display ON/OFF, Save No., Select No.

� Some items may not be controlled depending on the projector
model to be controlled.

� Refer to the projector’s operation manual for details on each
adjustment.

� “Fine Sync” adjustment is not necessary except “Auto Sync
Setup” and “Special Modes” with Input3 (DVI) mode when using
the DVI digital RGB input terminal. (The “Input Adjust” and
“Settings” items cannot be adjusted.)

� Make a note of the “Save No.” and its stored setting, if necessary.
You cannot check each setting with this software after saving it.

� The previous setting will be overwritten if you save on the same
“Save No.” button.
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“Audio” Adjustment

E. g. The display below is the one that appears when used with the XG-
C50X projector.

You can perform the adjustments, settings or functions below on this
sheet:
Balance, Treble, Bass, Audio Out, Speaker ON/OFF, Volume,  Mute
ON/OFF

� Some items may not be controlled depending on the projector model
to be controlled.

� Refer to the projector’s operation manual for details on each
adjustment.



68

Single Multi

“Options” Adjustment
E. g. The display below is the one that appears when used with the XG-

C50X projector.

You can perform the adjustments, settings or functions below on this
sheet:
DNR ON/OFF, Auto Power Off (Automatic Power Shutoff) ON/OFF,
OSD Display, Video System, Background Image, Startup Image,
PRJ Mode, Set Inputs, Power Save Mode

� Some items may not be controlled depending on the projector model
to be controlled.

� Refer to the projector’s operation manual for details on each
adjustment.

� The Automatic Power Shutoff function will not operate when
performing Advanced Control for Adjustment, although you set
it “ON”.This function operates during Presentation Transfer,
Capture & Transfer, or Gamma Correction.

Getting Information of projector
Click the “Get Information” (Lamp & Signal information) button to
open the “Information” window.
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“Model”
Shows the model number of the projector.

“Power Status”
On: The power is on.
Off: The power is off.
Cooling: The power is off with the cooling fan turning. Do not

disconnect the power cord during “Cooling”.
“Lamp Status”

On: The lamp is on.
Off: The lamp is off.
Retry: Retrying to turn on the lamp.
Wait: Checking if the lamp is on.

“Lamp Timer”
Shows the accumulated lamp usage time. It will be reset when
replacing the lamp.

“Lamp Life”
Shows the remaining lamp life in percentage. It will be reset when
replacing the lamp.

“Trouble Status”
Temp.: The internal temperature is abnormally high. Something

may be blocking the air intake.
Fan: The filter cover is open. Securely install the filter cover.
Lamp: The lamp has a problem.
Normal: Displayed in the normal operating condition.

“Real Resolution”
Shows the resolution of the projector’s panel.

“Input Status”
Shows the selected INPUT.

“Resolution”
Shows the resolution of the computer image when projected on the
screen.
This item will not be displayed when using the t-‰eo source (NTSC
or PAL).

“Hor Freq”
Shows the horizontal frequency (kHz).
This item will not be displayed when using the video source (NTSC
or PAL).

“Vert Freq”
Shows the vertical frequency (Hz).
This item will not be displayed when using the video source (NTSC
or PAL).

“Video System”
Shows the video input system (NTSC or PAL etc.). “---” will be
displayed when the signal is a monochrome or when there is no
signal. For a forced system, an “*” will be at the start of the system
name.

Some items may not be displayed depending on the projector model.
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“C.M.S” Adjustment

E. g. The display below is the one that appears when used with the XG-
C50X projector.

You can perform the adjustments, settings or functions below on this
sheet:
Color Selected, Target, Lightness, Chroma, Hue

� Some items may not be controlled depending on the projector model
to be controlled.

� Refer to the projector’s operation manual for details on each
adjustment.
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Save Control Setting and Load Control Setting

You can save all the current Advanced Control for Adjustment settings
of the projector in your PC (Save Control Setting) and also load the
Advanced Control for Adjustment settings saved in the PC to the
projector (Load Control Setting).

To make “Save Control Setting”
Click the “File” menu to select “Save Control Setting”.
All the current Advanced Control for Adjustment settings of the
projector will be saved in the SAPS folder in the PC.

To make “Load Control Setting”
Click the “File” menu to select “Load Control Setting”.
The Advanced Control for Adjustment values will be loaded to the
connected projector.

� You cannot use this function when “XGNV1-5” is selected in
“Projector Setting” dialog box.

� The projector must be identical for the “Save Control Setting” and
“Load Control Setting”.
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Video Wall Setting

With this software, the image from the connected projectors can be
divided from 2 × 2 to up to 8 × 8 to create a video wall.

� This function is not available when UXGA signals are displayed.
� This function can only be used with the XG-V10 Series, the XG-P20X

and the XG-P25X.
� The projector forming a video wall must belong to a group. To assign

a projector not belonging to a group, add the projector to one of the
groups. (See page 35.)

1 Click “Video Wall Setting” in the “Mode” menu.
You can also select “Video Wall” by clicking the  icon.
| The “Video Wall Setting” window will open.

1 Area assigned to the selected projector
2 Select “Division”.
3 Select “Group Name”.
4 Projector selection area
5 Assign the projector.
6 Adjust: The position of the assigned projector can be adjusted in the

horizontal (H) and vertical (V) directions by clicking ', ", \
and |.

2 Select the group.

3 Select “Division”.

4 Select the position to assign in “Position Assignment”.

For the relationship between the position assigned here and the
actual position of the projector, see “Projector image assignment
with the Video Wall Setting” on page 74.

1

6

3

2

4

5
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5 Select the projector in the Projector selection area.

6 Click “Assign”.
The projector is assigned as a video wall component.

7 Click “Transmit”.

To fine-adjust the vertical and horizontal position

1 Select the image you want to fine-adjust in “Position
Assignment”.

2 Adjust the image position using ', ", \ and | buttons.

To reset the current assignment settings

1 Select the projectors whose assignment you want to
cancel in “Projector Selection area”.

2 Click “Reset & Transmit”.
The Video Wall Setting of the selected projectors is canceled.
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Projector image assignment with the Video Wall Setting
The projector image assignment for front projection and rear projection
is shown below.

Front projection
1

4

7

2

5

8

3

6

9

1

4

7

5

8

6

9

2 3

1 to 9 correspond to position numbers on the screen.

Rear projection

1

4

7

2

5

8

3

6

9

1

4

7

2

5

8

3

6

9

1 to 9 correspond to position numbers on the screen.
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Settings and considerations regarding the Wide Video Wall
The Wide Video Wall can be implemented when choosing from 2 × 1,
3 × 1, 4 × 1, 5 × 1, 6 × 1, 7 × 1, 8 × 1 in “Division” (page 72).

Example of the Wide Video Wall setting (3 × 1)

Line up the 3 projectors beside each other as shown above for setting
the Wide Video Wall, and input the edited images as shown below into
the projectors, after selecting “3 × 1” in “Division” and setting the Position
Assignment.

� Using the XG-P20X or the XG-P25X

Input the image compressed horizontally to 1/3.

� Using the XG-V10 Series

1 / 3

1 / 3

1 / 3

Input the image using only the central 1/3 area of the vertical direction.
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Adjusting Images

Gamma Correction

Changing the gamma value adjusts the tone of an image on the screen.

This function is only available in the “Single Projector Operation Mode”.

Before Adjusting
� Use the projector’s Gamma button to set the CUSTOM mode.
� Infrared communications (IrCOM) cannot be used when performing

gamma correction. Connect a serial cable or LAN cable to the projector
and the PC (page 10), then proceed to Gamma Correction.

1 Select the “Gamma Correction” mode.
See section “Opening Modes” (page 20).
| The “Gamma Correction” window will open.

1 Specify the source of the image. The default setting is
“COMPUTER”

2 Each of these colors except “WHITE” can be adjusted respectively.
As you adjust “WHITE”, the values of the other three colors will be
offset.

2

6

5

3
4

1
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The “Reset & Transmit” button resets the values of the color
currently selected. If you want to reset both the red and green
values, click the “Reset & Transmit” button in the “RED” mode,
and then click the “Reset & Transmit” button again in the
“GREEN” mode. If you want to reset to the original values, click
the “Reset & Transmit” button in the “WHITE” mode.

3 To restore to the previous status after operating the gamma data.
4 To restore the status before the “UNDO” button was clicked.
5 To send all the adjustment signals to the projector
6 Gamma coordinate display (INPUT/OUTPUT)

2 Select the “InputMode”.

3 Adjust the values of each color.
Drag and drop the curve of the graph to adjust it to the proper value.

4 Click “Transmit”.
| The “Now Transmitting...” message is displayed during

transmission.
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Adjusting the Gamma Curve

1 Repeat steps 1-2 of “Gamma Correction”.

2 Place the mouse pointer over the gamma curve.

The mouse pointer takes the shape of an open hand.

3 Drag the gamma curve.

The mouse pointer takes the shape of a closed hand and the curve
changes.
The same operation is possible using the up and down arrow keys
on the keyboard.
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Setting the gamma correction area
You can set the gamma correction area by using Drag and Drop. The
gamma curve and mouse pointer moves within the set range after setting
the gamma correction area.
The gamma correction area can also be set by using the right and left
arrow keys on the keyboard while pressing the shift key.

1 Drag the mouse pointer, then drop it.
The point at which the mouse pointer is released is set as the
correction area.

2 Drag and drop the gamma curve.
The Gamma curve or mouse pointer moves within the set range.

� To restore the previous status after operating the gamma data, click
the “UNDO” button.

� To restore to the status before the “UNDO” button was clicked, click
the “REDO” button.
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Saving the Gamma Correction Settings

1 Select “File”, then select “Save Gamma Data”.
| This opens the “Save As” dialog box.

2 Specify a “File name”.

3 Specify a “Save In” location.

4 Click “Save”.
The current gamma correction settings of the projector will be saved.

Loading the Gamma Correction Settings

1 Select “File”, then select “Load Gamma Data”.
| This opens the “Open” dialog box.

2 Specify a file location in “Look in”.

3 Specify a “File name”.

4 Specify a “Files of type”.

5 Click “Open”.
The gamma correction values will be loaded to the connected
projector.

Resetting Gamma

1 Select in “Custom” those colors whose values you want
to return to the default setting.

When selecting “WHITE”, the gamma curves of all the colors return to
the default setting.

2 Click “Reset & Transmit”.
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Setup for Transferring Images

Changing Compression Rate

When transferring a BMP image file by Presentation Transfer or
Capture & Transfer, you can change compression rates.

This mode cannot be used with the XG-V10 Series, the XG-P20X or the
XG-P25X projector.

Compression rate
� The default setting for image quality is “middle”.
� If you are transmitting the custom Image (BMP) used as Startup Image

and Background Image, the image is automatically transmitted as
“High quality, slow transmission” for best results. The BMP file will be
transferred without any conversion to minimize the loss of image quality.

� If adjusted, the compression rate will be saved in each image folder
as a file. The converted files then remain in the folder so that the
conversion time can be shortened thereafter.

1 Click the “Option” menu, and select “Compression Rate”.

Better image quality
but slower transmission

Faster transmission
but poorer image
quality

2 Drag and drop the pointer to the rate position you desire.

3 Click “OK”.
| The compression rate in the selected folder changes.
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Transferring Images

Presentation Transfer

This mode makes it possible to transfer images saved as BMP or JPEG
files to the projector. A preview of the slides in the file folder selected is
displayed on the PC monitor.

� This function is only available in the “Single Projector Operation Mode”.
� If you use the NV5/6/7, infrared communications can be available.

Before Presentation
� Save beforehand the images you want to project using the following

file formats and image sizes.

1 Select the “Presentation Transfer” mode.
See section “Opening Modes” (page 20).
| The “Presentation Transfer” window will open.

1 5

4

6

3

2

1 Images in the selected folder (step 3)
2 Information of the selected image
3 Selecting the type of “Transfer Mode” (step 4)
4 Selecting the Presentation Method
5 Starts the “Self Run” transfer (page 85).
6 “Send Image” Transfer (page 84).

V10W
P20X
P25X
V10X
C30X
C40X
C45

C50X
NV5-7
P10X

Image size (max.)
1280 × 1024

1024 × 768

1024 × 768

File format
BMP

BMP

BMP
or

JPEG
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2 Click the “File” menu, and select “Open”.

3 Select the folder where the image files (Presentation
Slides) are saved, and click “OK”.
| The images in the selected folder are previewed in the

“Presentation Transfer” window.

If the size of the image is smaller than the panel resolution on the
projector, the image will be displayed with black areas. However,
the software will transfer the image in the original resolution.

4 Select “Image Transfer” in “Transfer Mode”.

For details on the “Custom Image Transfer”, see pages 90, 91.

5 On the projector side, the screen is automatically set to
the CUSTOM mode.
To restore the previous screen, press the INPUT select button
(INPUT1~5).

� For NV5/6/7 users:
The projector must be in IrCOM mode to receive the images.
Press the “IrCOM” button on the projector or the remote control.

� For the “Self Run” transfer, skip over to section “To send all the
images (“Self Run”)” on page 85.
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To send a single image (“Send Image”)
1 Select an image in the “Presentation Transfer” window

to transfer.
If you want to change the compression rate, see the section
“Changing Compression Rate” (page 81).

� The compression rate is applied to all the images in the selected folder.
� Changing the compression rate will change the image picture

quality and transfer speed.

2 Click the “Current” button in the “Send Image” box.
| The “Transmitted File Information” dialog box appears and the

transfer begins. If you want to stop the transfer, click “CANCEL”.

| To send the next image, click the “Next>” button in the “Send
Image” box.

| To send the previous image, click the “<Previous” button in the
“Send Image” box.

| The default order of images follows the file name.
You can change the order of the image files by dragging and
dropping them to the desired location.
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To send all the images (“Self Run”)

1 Select the desired method in “Self Run”.
“Continuous” sends all images in the specified folder continuously.
“Once” sends all images in the specified folder once.

2 Select the interval to send images in “Self Run”.
You can select it in the range from 30 seconds to 5 minutes fixed in
units of 15 seconds.

3 After step 4 on page 83, click the “Start” button in the
“Self Run” box of the “Presentation Transfer” window.
| The “Transmitted File Information” dialog box will appear and

the transfer will begin. If you want to stop the transfer, click “Skip”.

| After the transfer is completed, the “Slide wait” dialog box will
appear until the image will be projected on the screen. If you
want to cancel the interval and soon show the next image, click
“Next>>”.

| To cancel “Self Run”, click “Exit”.
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Capture & Transfer

This mode allows you to transfer an image of what is currently displayed
on the PC monitor.

� This mode is only available in the “Single Projector Operation Mode”.
� If you use the NV5/6/7, infrared communications are available.

Before Presentation
� This function is not available for full screen slides (e.g. the “Slide

Show” mode of Microsoft PowerPoint).
For full screen slides to use Capture & Transfer, see the section
“Quick Transfer” (page 88).

1 Display the image you want to transfer.

2 Select the “Capture & Transfer” mode.
See section “Opening Modes” (page 20).
| The “Capture & Transfer” window will open.

Selecting the type of 
“Transfer Mode” (step 3)

3 Select “Image Transfer” in “Transfer Mode”.
If you want to change the compression rate, see the section
“Changing Compression Rate” (page 81).

� For the details of the “Custom Image Transfer”, see pages 90,
91.

� Changing the compression rate will change the image picture
quality and transfer speed.
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On the projector side, the screen is automatically set to the CUSTOM
mode.

For NV5/6/7 users:
The projector must be in IrCOM mode to receive the images. Press the
“IrCOM” button on the projector or the remote control.

4 Click the “Capture & Transfer” button in the “Capture &
Transfer” window.
| The “Capture & Transfer” window disappears and capturing

begins.
| After capturing is completed, the “Capture & Transfer” window

reappears and transfer of the captured image begins.
| The “Transmitted File Information” dialog box appears.

If you want to stop the transfer, click “CANCEL”.

To send another image
Change the image displayed on the PC monitor and then repeat step 4.
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Quick Transfer

By applying the preset compression rate, this mode allows you to transfer
images using simple steps.

� This function does not work with the following models:
XG-P20X, XG-P25X, XG-V10X, XG-V10W, XG-NV1-4

� This mode transfers images under the following settings which cannot
be modified.
• Normal picture quality
• Compression rate: Middle

The custom image used as Startup Image and Background Image
cannot be transferred in this mode.

Before Presentation
� Confirm that the “Auto-Launch” setting is “ON” (page 22) or the

software is active.
� This function is available for full screen slides (e.g. the “Slide Show”

mode of Microsoft PowerPoint).

1 Display the image you want to transfer.

2 Hold the right mouse button down for 2 seconds.
The position of the pointer can be anywhere on the display.
| The “Quick Transfer” window opens.

On the projector side, the screen is automatically set to the CUSTOM
mode.

For NV5/6/7 users:
The projector must be in IrCOM mode to receive the images. Press the
“IrCOM” button on the projector or the remote control.
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3 Click the “Capture & Transfer” button in the “Quick
Transfer” window.
| The capturing begins.
| The “Transmitted File Information” dialog box appears and

the transfer of the captured image begins.
If you want to stop the transfer, click “CANCEL”.

| After the transfer is completed, the “Transmitted File
Information” dialog box disappears.

4 Click “EXIT” in the “Quick Transfer” window.

To send another image
Change the displayed image on the PC monitor and repeat from step 2.
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Saving a Custom Image as Startup Image and Background Image

The projector has an option to display a custom image (e.g. your company
logo) upon startup of the projector (Startup Image) or when there is no
signal (Background Image).
You can choose your custom image from the projector’s mode menu.
Refer to the projector’s operation manual for how to set Startup Image
and Background Image.
Use Presentation Transfer or Capture & Transfer, when sending a
custom image to the projector.

Make sure to prepare beforehand image files, which satisfy the following
conditions, when sending custom images to the projector using
Presentation Transfer.

*1: • Images, which go over 240 colors, are reduced automatically to
240 colors when transferred.

• For best results, create your image with a 240-color palette. A
256-color palette can also be used, however there may be some
image quality lost during transfer.

This function does not work with the following models:
PG-C45 Series, XG-C50X, XG-NV1-4

Image size (max.)
1280 × 1024

1024 × 768

File format

BMP

Color (max.)

24 bit true color (*1)

V10W
C30X
C40X
NV5-7
P10X
P20X
P25X
V10X
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1 Select “Custom Image Transfer” in “Transfer Mode”.
Refer to “Transferring Images” (page 82) for how to transfer the
image.

2 Click “Current” in the “Presentation Transfer” window or
click “Capture & Transfer” in the “Capture & Transfer”
window to transfer images.
| The preview window is displayed.

If the original image goes over 240 colors, an image reduced to 240
colors will be displayed.
If you want to save color reduced images, click the “Save Image”
button.

3 Click “Send Image”.
The image is transferred to the projector.

� When you want to clear the custom image stored in the projector,
cancel the transmission during custom image transfer. The custom
image stored in the projector will be cleared.

� The “Custom Image Transfer” mode saves one image file only and
overwrites the previously transferred image if you send another image
file.

� To avoid erasing the custom image, you should change the transfer
mode to “Image Transfer” after sending the custom image.
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V10, P20X, P25X

Single
Multi

No ID ID

P10X, C30X, C40X, C45, C50X

Single Multi

NV5-7

Single Multi

NV1-4

Single Multi

Serial
(RS-232C)

IrCOM
(IrDA)

LAN

Network Control
Gamma Correction
Presentation
Network Control
Gamma Correction
Presentation
Network Control
Gamma Correction
Presentation

√ √ √
√ - -
√ - -
- - -
- - -
- - -

√*1 - √*1

√*1 - -
√*1 - -

√ √
√ -
√ -
- -
- -
- -
- -
- -
- -

√ √
√ -
√ -
- -
- -
√ -
- -
- -
- -

√ √
- -
- -
- -
- -
- -
- -
- -
- -

*1: With Optional Expansion Board (when using the XG-V10 Series only)

√ √ √
√ √ √
√ √ √
- - √
√ √ √
√ √ √
√ √ √
√ √ √
√ √ √

√ - -
√ - -
√ - -
√ - -
- √ √
- - √

√ √ √
- - -

- √ √
√ √ √
√ √ √
- √ √
- √ √
- √ √
- √ √
- √ √
- √ √

√ √
√ √
√ √
- -
√ √
√ √
√ √
√ √
√ √

√ -
√ -
√ -
√ -
- √
- -

√ √
√ √

- √
√ √
√ √

√*2 √*2

- √
- √
- √
- √
- √

√ √
√ √
√ √
- -
√ √
√ √
√ √
√ √
√ √

√ -
√ -
√ -
√ -
- √
- -

√ √
√ √

- √
- -
- -
- -
- √
- √
- √
- √
- √

√ √
√ √
√ √
- -
√ √
√ √
- -
- -
√ √

- -
- -
- -
√ -
- √
- -

√ √
- -

- √
- -
- -
- -
- √
- √
- √
- √
- √

MENU V10, P20X, P25X P10X, C30X, C40X, C45, C50X NV5-7 NV1-4

Table of Functions by Model

The table below shows the available function for other projector.
√ : Signifies available function

- : Signifies unavailable function

*2 : This function is available with the PG-C45 Series and the XG-C50X projectors only.
•  ID setting is available with the XG-V10 Series, the XG-P20X and the XG-P25X projectors only.

File
Open
Operation Mode Setting
Projector Setting
Scan Setting
Save Control Setting
Load Control Setting
Save Gamma Data
Load Gamma Data
Exit

Mode
Capture & Transfer
Presentation Transfer
Gamma Correction
Single Control
Multiple Control
Video Wall Setting

Option
Auto-Launch ON / OFF
Compression Rate

Control Option
Projector Timer Control
Password
Keylock Level
Projector / Unique Name
Group Setting
E-mail Address Book
Send E-mail Setting
Error Log Viewer
Configuration
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Troubleshooting

Unable to transfer images or an error occurs with communication

\ Check that the connection type is surely selected as you intend.

\ Check that the image size is 1280 × 1024 or lower.

In case of cable communications (RS-232C and LAN)
\ Check whether the transmission speed set at “Projector Setting”or

“Scan Setting” is the same as the transmission speed set at
“RS-232C” on the projector’s OSD menu.

\ Make sure that the settings of the RS-232C port on the PC are as
follows:

Data length: 8 bits
Parity bit: None
Stop bit: 1 bit
Flow control: None

\ Check that the port for the RS-232C serial cable or LAN cable is
correctly specified in the PC’s settings.

\ Check that the cable is correctly and securely connected (page 10).

In case of infrared communications (IrCOM)
\ Check that the infrared ports (the projector and the PC) are within

1 meter (3 ft.) distance and keep the vertical and horizontal range
within 30 degrees.

\ Check that there are no obstacles between the projector and the PC.

\ Avoid using this function under strong lighting conditions.
Strong light sources such as sunlight or fluorescent lighting may
interfere with image transmissions.

\ Check that the projector is in the IrCOM mode before transferring
images from the PC. (See the projector operation manual.)
The On-screen Display “IrCOM stand by” or “IrCOM stand by,
Waiting for Data” will appear on the projection screen.

\ Check that your PC’s IrDA port is activated and configured properly.
Check the PC’s  instruction manual.

\ Check the “Connection Type” in Single Projector Setting (page 30).

\ Confirm that the port for infrared communications is correctly
specified in the PC’s settings.

\ For Windows 95 users: Check that Microsoft’s IrDA 2.0 (Infrared
Driver) is installed (page 9).

\ Check that the display mode is appropriate for  the images. (Normal
transfer: 24 bit color or less; “Startup Image” transfer: 256 colors for
BMP files)

\ Infrared communications (IrCOM) cannot be used with Windows
NT4.0 Workstation, Me, 2000 Professional, XP Home or Professional
Edition.
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“Gamma Correction”/“Advanced Control for Adjustment” is not
operating properly

\ Reconnect the RS-232C serial cable or LAN cable and try again.
The cable may not be connected properly or an error may have
occurred during the transmission.

\ Check that the port for serial (RS-232C) communications is correctly
specified in the PC’s settings (page 30).

\ Projector may not be receiving command because of the projector’s
setting. Please check the projector’s “ON/OFF” status, “INPUT
SELECT” status (COMPUTER, VIDEO) or the input signal. Resend
the command after adjusting these items.

\ Before Gamma Correction, use the projector’s Gamma button and
set the CUSTOM mode.

The transmitting speed is low

\ Do not use the projector’s remote control while transferring.

\ Check the compression rate setting (page 81).

\ Check the Transmission Speed setting, in the case of RS-232C cable
communications (page 29).

\ Note that custom image as Startup Image and Background Image
is fixed in the “High quality, slow transmission” setting.

\ Note that Quick Transfer is fixed in the “Normal quality, middle speed”
setting.

\ Check that your PC supports IrDA 1.1.

\ Check the transmitting speed from your PC.
If the speed is 4 Mbps, check that an IrDA 1.1 driver is installed
(page 9). Refer to the PC’s instruction manual.

If 4 Mbps IrDA should fail

\ If 4 Mbps IrDA should fail, try transmitting at 115 kbps. The following
is the procedure to change the transmitting speed.
1) Click the Windows “Start” button and then select “Settings”.
2) Select “Control Panel”.
3) Double click the “Infrared” icon.
4) Click the “Options” tab.
5) Select “Limit connection speed to” and change it to 115kbps.
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Unable to save the startup image

\ Do not turn off the projector while transmission.
The image data may be lost.

Quality of the image is low

\ Check the compression rate setting (page 81).

\ Note that Quick Transfer is fixed in the “Normal quality, middle speed”
setting.

Unable to speed up the transfer or improve the image quality

\ If the image file is saved in JPEG format, its compression rate cannot
be changed.
Note that the compression rate only applies to BMP file format.

Unable to speed up “Gamma Correction” though the
transmitting speed was changed

\ The transmitting speed setting applies to image transfer via cable
only. The speed for transfer of gamma values is fixed at 9,600 bps.
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List of Error Messages

The internal temperature is abnormally high.
The internal temperature is high.
Temperature Error

[Problem]
Blocked air intake. / Clogged air filter.
Cooling fan breakdown. / Internal circuit failure.
[Possible Solution]
a. Relocate the projector to an area with proper ventilation.
b. Replace the filter.
c. Take the projector to your nearest Authorized Sharp Industrial LCD Products Dealer or

Service Center for repair.

The cooling fan is not operating.
Internal Cooling Fan Error

[Problem]
Cooling fan breakdown.
[Possible Solution]
Take the projector to your nearest Authorized Sharp Industrial LCD Products Dealer or
Service Center for repair.

The filter cover is open.
Filter Cover Error

[Problem]
The filter cover is not properly mounted, or filter is not properly mounted.
[Possible Solution]
Mount the filter cover and filter properly.

If this error message appears even though the filter cover is properly mounted, take the
projector to your nearest Authorized Sharp Industrial LCD Products Dealer or Service
Center for repair.

The remaining lamp life is below 100 hours.

[Possible Solution]
a. Carefully replace the lamp and reset the lamp timer.
b. Take the projector to your nearest Authorized Sharp Industrial LCD Products Dealer or

Service Center for repair.

The lamp is burnt-out.

[Possible Solution]
a. Carefully replace the lamp and reset the lamp timer.
b. Take the projector to your nearest Authorized Sharp Industrial LCD Products Dealer or

Service Center for repair.
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Lamp Error
The lamp does not ignite.

[Problem]
Burnt-out lamp. / Lamp circuit failure.
[Possible Solution]
a. Carefully replace the lamp and reset the lamp timer.
b. Take the projector to your nearest Authorized Sharp Industrial LCD Products Dealer or

Service Center for repair.

No response from the projector.
Communication Error

[Problem]
Communications with the projector cannot be established for some reason.
[Possible Solution]
Set the computer and projector to the same communications speed.
Check the connections of the cables.

COM1 is already used by other application software.

[Possible Solution]
Use a COM port not being used by another application software.

Failed to connect to the projector via LAN.

[Problem]
The projector is being controlled already from another PC via the LAN.
[Possible Solution]
Cancel the control from the other PC.

This command cannot be used with this projector now.

[Problem]
A projector with that function has not been selected in “Projector Setting”.
[Possible Solution]
Select an appropriate projector in “Projector Setting”.

Some functions may not be usable under certain circumstances. For example, the “Auto
Sync.” function cannot be used if no image source is being input to the projector. The
above error message appears in such cases as well.
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Unable to connect to the e-mail server (SMTP server).

[Problem]
Could not connect to e-mail server (SMTP server) for sending e-mail messages.
[Possible Solution]
There may be no such e-mail server in the network or the server may be down. For
details, contact the system operator.

Incorrect sender e-mail address

[Problem]
E-mail sender’s e-mail address has not been properly input.
[Possible Solution]
Input the proper e-mail address.

Incorrect recipient e-mail address

[Problem]
E-mail recipient’s e-mail address has not been properly input.
[Possible Solution]
Input the proper e-mail address.

IP Address is imperfect.
Please input the correct IP Address.

[Problem]
The IP address input at “Scan Setting” is not correct.
[Possible Solution]
Input the proper IP address.
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22

32

90

3

86

10

81

90

91

79

53

23

23

76

76

35

Glossary

Version information

Specify if this software launches automatically upon
startup.

Function turning both “Black Screen” and “Mute” on.

Image displayed when no signal is input. Background
Image uses the same image data as Startup Image.

Image file format

Transfer an image of what is currently displayed on a
monitor.

Communication port

Rate of compression of the images transmitted from a
PC to the projector

General term for background image and startup image

Transfer the custom image to the projector. (Unless the
custom image is transferred again (overwritten), the
screen is retained in the projector’s memory.)

Select an item and modify it using the mouse.

Browse the log of errors generated in the multiple projector
operation mode.

Exit from this software

Main menu item

Projector’s specific values of specified colors

Adjust the projector’s gamma values from PC.

Make the settings for controlling groups of projectors in
the multiple operation mode.

About This Software

Auto-Launch ON/OFF

AV Mute

Background Image

BMP

Capture & Transfer

COM

Compression Rate

Custom Image

Custom Image Transfer

Drag & Drop

Error Log Viewer

Exit

File

Gamma

Gamma Correction

Group Setting

Word Explanation Page
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Word Explanation Page

Help

ID

Image Transfer

IP

IP Address

IrCOM

IrDA

JPEG

Keylock Level

LAN

Mode

Multiple Control

Multiple Operation
Panel

Open

Operation Mode

Option

Password

Presentation Transfer

23

24

82

26

26

9

9

3

40

10

22

32

32

83

25

22

37

82

Help in using this software

For specifying the individual projectors when controlling
multiple projectors simultaneously.

Transfer the image to the projector. (Unlike custom image
transfer, not stored in projector.)

Abbreviation of “Internet Protocol”

Address for specifying the computer on network.

Sharp infrared wireless communication

Abbreviation of “Infrared Data Association”. Name of
infrared communications standardization group and name
of standards

Abbreviation of “Joint Photographic Experts Group”
“JPEG” is an image file format.

Set whether to enable or disable operating buttons on
projector.

Local Area Network

Main menu item

Simultaneous control of multiple projectors from PC.

Operating panel for integrated control of projectors in
multiple projector operation mode.

Open file folder containing images to be transmitted to
the projector (for Presentation Transfer)

Set whether to control a single projector or multiple
projectors.

Main menu item

When a password is set, some functions can only be
changed by the person with the password.

Transfer a series of images (BMP or JPEG) to the
projector
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Word Explanation Page

Projector Name

Projector Setting

Projector & Unique
Name

Quick Transfer

RS-232C

Single Control

Scan

Scan Setting

Self Run

Serial Number

Startup Image

Transfer Mode

Transmission Speed

Unique Name

Names freely given to individual projectors. Unlike “Unique
Name”, can be changed freely by anyone.

Set the method of communication with the projector.

Make and change the “Projector Name” and “Unique
Name” settings.

Shortcut to transferring an image of what is currently
displayed on a monitor

Serial interface protocol with which many PCs are
equipped.

Control a single projector from a PC.

Function for searching for all connecting projectors and
automatically identifying them.

Set the COM port and IP address for searching with the
scan function.

Scan slides in a specified folder one after another to the
projector

Serial numbers assigned to individual projectors

Image displayed when projector turned on. Startup Image
uses the same image data as Background Image.

Change the function from “Custom Image Transfer” and/
or “Image Transfer”

Transmission speed via the projector’s RS-232C port and
PC’s serial port.

Names given to individual projectors. Unlike “Projector
Name”, when the password setting is set, can only be
changed by person with password.

42

28

42

88

9

62

26

26

85

26

90

91

26

42
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Services
Please contact nearest Sharp dealer if there are any problems.
For user purchased the projector in following countries, you can contact to the addresses shown if you have problems.
U.S.A.
Sharp Electronics Corporation
1-888-GO-SHARP (1-888-467-4277)
lcdsupport@sharpsec.com
http://www.sharplcd.com

Canada
Sharp Electronics of Canada Ltd.
(905) 568-7140
http://www.sharp.ca

Mexico
Sharp Electronics Corporation Mexico Branch
(525) 716-9000
http://www.sharp.com.mx

Latin America
Sharp Electronics Corp. Latin American Group
(305) 264-2277
www.servicio@sharpsec.com
http://www.siempresharp.com

Germany
Sharp Electronics (Europe) GMBH
01805-234675
http://www.sharp.de

U.K.
Sharp Electronics (U.K.) Ltd.
0161-205-2333
custinfo@sharp-uk.co.uk
http://www.sharp.co.uk

Italy
Sharp Electronics (Italy) S.P.A.
(39) 02-89595-1
http://www.sharp.it

France
Sharp Electronics France
01 49 90 35 40
hotlineced@sef.sharp-eu.com
http://www.sharp.fr

Spain
Sharp Electronica Espana, S.A.
93 5819700
sharplcd@sees.sharp-eu.com
http://www.sharp.es

Switzerland
Sharp Electronics (Schweiz) AG
0041 1 846 63 11
cattaneo@sez.sharp-eu.com
http://www.sharp.ch

Sweden
Sharp Electronics ( Nordic ) AB
(46) 8 6343600
vision.support@sen.sharp-eu.com
http://www.sharp.se

Benelux
SHARP Electronics Benelux BV
0900-SHARPCE (0900-7427723) Nederland
9900-0159 Belgium
http://www.sharp.nl
http://www.sharp.be
http://www.sharp.lu

Austria
Sharp Electronics Austria (Ges.m.b.H.)
0043 1 727 19 123
pogats@sea.sharp-eu.com
http://www.sharp.at

Australia
Sharp Corporation of Australia Pty. Ltd.
1300-135-022
http://www.sharp.net.au

New Zealand
Sharp Corporation of New Zealand
(09) 634-2059, (09) 636-6972
http://www.sharpnz.co.nz

Singapore
Sharp-Roxy Sales (S) Pte. Ltd.
65-226-6556
ckng@srs.global.sharp.co.jp
http://www.sharp.com.sg

Hong Kong
Sharp-Roxy (HK) Ltd.
(852) 2410-2623
dcmktg@srh.global.sharp.co.jp
http://www.sharp.com.hk

Malaysia
Sharp-Roxy Sales & Service Co.
(60) 3-5125678

U.A.E.
Sharp Middle East Fze
971-4-81-5311
helpdesk@smef.global.sharp.co.jp

Thailand
Sharp Thebnakorn Co. Ltd.
02-236-0170
svc@stcl.global.sharp.co.jp
http://www.sharp-th.com

Korea
Sharp Electronics Incorporated of Korea
(82) 2-3660-2002
webmaster@sharp-korea.co.kr
http://www.sharp-korea.co.kr

India
Sharp Business Systems (India) Limited
(91) 11- 6431313
service@sharp-oa.com

Information
You can see information about Sharp projectors on the following website. http://www.sharp-
world.com/projector/
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